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Section 1:  SEER*Abs Installation

The registry’s first installation of SEER*Abs should be on the workstation of the registry’s SEER*Abs system administrator.  The system administrator will configure SEER*Abs and create a registry-specific installation program for you and other SEER*Abs users at the registry.

To install SEER*Abs on your computer:

1. The SEER*Abs software requires Java 1.6.0 or later.  Follow these steps to determine the version of Java installed on your computer:

a. Enter java -version at a DOS prompt.
b. If you do not have the required version, uninstall the existing version of Java and install the latest version. More information related to the appropriate version of Java is provided on the SEER*Abs Web site (seer.cancer.gov/seerdms/portal/seerabs).
2. Install SEER*Abs by executing the SEER*Abs installer provided to you by your registry’s SEER*Abs system administrator.    Please refer to the SEER*Abs Installation Guide or documentation provided by your registry’s system administrator for further instructions.
Section 2:  Introduction to SEER*Abs

Install your registry’s version of SEER*Abs on your laptop.  The system configuration defines how patient and record data are displayed in the system, the availability of reference data, your username and initial password, and your Abstractor ID.  Please contact your registry’s IT staff for assistance with the SEER*Abs installation or to request changes to the configuration.  

Logging In

Your user name and initial password were defined by your registry’s system administrator when SEER*Abs was configured for your laptop.  If a shortcut was created, the SEER*Abs icon [image: image1.wmf] will be displayed on your desktop or in your system tray.

To log in: 

1. Click the SEER*Abs icon or double-click the seerabs.exe executable file.  SEER*Abs will load configuration files and execute initialization scripts.  You may continue with the login process while SEER*Abs loads and executes the scripts.
2. Enter your username and password.  The username field will default to the username entered in the previous session.
3. If your work will be related to data for one facility, you may specify the Facility on the login page.  This sets the Current Facility for your session.  The Current Facility is used as the default facility in the worklist and, depending on your registry’s configuration; it may be used as a default value for some data entry fields.  It may also be used in scripts that create extracts and download data from your registry database.  Consult your registry’s SEER*Abs system administrator to determine the ways in which the Current Facility is used.   

a. To specify the Current Facility on the login page, enter the facility ID or use the lookup to search for a facility. SEER*Abs Facility IDs are the same as those in your central registry’s data management system.  If your registry uses SEER*DMS, you do not have to enter the FAC- prefix.  

b. If you are not working on data for a single facility or if you have not yet downloaded the facility list from your central registry’s database, you may leave this field blank.  (Facility lists in SEER*Abs are updated when SEER*Abs is synchronized with data from the registry’s central database.)
4. Click Login.
5. If this is your first SEER*Abs Session, you will be prompted to change your password:

a. Enter a value in Password.  Password requirements are described below in the Changing Your Password section of this chapter.
b. Verify the new password by re-entering it into the Repeat Password field.


c. Click OK.
Changing Your Password

SEER*Abs provides access to confidential data.  It is your responsibility to protect and maintain your password according to registry policy.  Your registry may require that you periodically create a new password.  If you have forgotten your password, please contact the SEER*Abs system administrator at your registry. 

To change your password:

1. Select File > Change Password. (Keyboard alternative:  use Alt-F to access the file menu and the down arrow key to select Change Password.)
2. Enter your Current Password.
3. Enter a New Password.  All passwords must be at least 8 characters in length.  Security measures to protect the confidentiality of patient data must include the use of strong system passwords.  Your password should:

a. Include symbols, digits, and letters of both upper and lower case.  You must use at least one lower case letter, one upper case letter, and one digit or punctuation mark.

b. Be significantly different from passwords that you have used in the past.

c. Not include your name, your username, your child’s name, or your pet’s name.

d. Not be a common word or name. 

4. Re-enter your new password in the Repeat New Password field.
5. Click OK.  Your new password will be effective immediately.
SEER*Abs Menus, Toolbar, and Shortcuts

Every item on the SEER*Abs menus can be accessed via keyboard short-cuts.  In addition, items on the Show menu can be accessed via toolbar icons.  When logged on as a standard user, the toolbar includes four items – Worklist, Editor, Search, and Synchronization.  The menus and tools for the standard user are described in this manual.  The Configuration, Users, and Log tools are only shown when logged on as the administrative user and are described in the SEER*Abs System Administration reference.  
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File Menu

	Shortcut
	Menu Item

	Alt+F, arrows
	New Abstract – opens a blank abstract record in the editor

	Alt+F, arrows
	New <other record types> – SEER*Abs can be configured to create records other than abstract and casefinding.  If your system administrator configured SEER*Abs to allow data entry of other record types, they will also be listed in the File menu.

	Ctrl+Shift+P
	Search Patient Data – opens the Patient Data tab of the Search page.  The search filters are reset.

	Ctrl+Shift+F
	Search Facilities – opens the Facility tab on the Search page.  The search filters are reset.

	Ctrl+Shift+Y
	Search Physicians – opens the Physician tab on the Search page.  The search filters are reset.

	Ctrl+Shift+D
	SEER*Rx – opens the SEER*Rx drugs on the Search page.

	Ctrl+Shift+I
	Hematopoietic Database – opens the Hematopoietic Diseases database on the Search page.

	Alt+F, arrows
	Backup Main Database – creates a backup of the data stored in the main SEER*Abs database.  Data entered in SEER*Abs, changes made to AFLs, and changes made to the user list are stored in the main database.  Reference data are not stored in the main database and are not included in this backup.

	Alt+F, arrows
	Restore Main Database – overwrites the main database using a previously created backup. You will be prompted to select the backup from your hard disk or network. 

	
	Import Reference Database – updates the reference data from a database created by the system administrator.  You will be prompted to select the main DB folder containing the reference data (a default folder may have been set in your registry’s configuration). 

	Alt+F, arrows
	Recreate Indexes – ensures that database indexes and tables are in sync.  Indexes are used by SEER*Abs to optimize database searches.  

Recreating the indexes will ensure that the indexes and database are in sync.  It is a good first step to try if you notice odd results in searches or when filtering.  It should be very rare that this would need to be done.

	Alt+F, arrows
	Package Application for Technical Support – creates a compressed file containing the files required by the Technical Support staff to track down an issue. Use this option only if requested by Technical Support.

	Alt+F, arrows
	Change Password – allows you to specify a new password.

	Alt+F, arrows
	Set Current Facility – allows you to change the Current Facility used throughout SEER*Abs.  You may select a facility or set Current Facility to none.  Current Facility is used as the default facility in the worklist and, depending on your registry’s configuration, it may be used as a default value for some data entry fields.  It may also be used in scripts that create extracts, download data from your registry database, or perform other functions.  Consult the SEER*Abs system administrator at your registry to determine the ways in which Current Facility is used.

	Alt+F, arrows
	Preferences – displays the User Preferences dialog.

	Ctrl+Shift+Q
	Exit – closes SEER*Abs.  You will be prompted to save any unsaved changes.


Show Menu

	Toolbar Icon
	Shortcut
	Menu Item
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	F1
	Worklist – opens or returns you to the SEER*Abs worklist.  When you first login, the worklist filters are set to show outstanding abstracting tasks (AFLs) for the current facility.  AFLs for all facilities will be displayed if you do not select a current facility.   
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	F2
	Editor - allows you to create new records.  Abstract and casefinding record layouts are defined for most registries; a short abstract layout is supported but is only available if defined in your registry’s configuration.
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	F3
	Search – opens the Search page.  If you have used the Search page in this session, the filters and results most recently displayed are restored.   

Use this to search patient, facility, and physician data in the SEER*Abs database.  These reference data are extracted from the registry’s main database or loaded from external files during synchronization.  Scripts maintained in the registry’s Configuration determine the contents of the reference data. 
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	F4
	Synchronization – allows users to update SEER*Abs with data from the registry’s data management system; and create extracts to update the registry’s data management system.

	
	
	Input Folder – displays the input folder (default folder used to import data files)

	
	
	Output Folder – displays the output folder (default folder used to create extracts)


Action Menu

	Shortcut
	Menu Item

	Alt+A, arrows
	Purge Archived Data – deletes archived AFLs and/or records older than that are older than a period of time defined in registry configuration settings.  Note:  This feature may be hidden in your registry’s configuration.

	Alt+A, arrows
	Your registry’s system administrator can customize the Action menu.  Other actions may be listed.  If your registry’s configuration does not support any actions, the Action menu will not be displayed.


Help Menu
	Shortcut
	Menu Item

	Ctrl+Shift+H
	User Manual – displays this document.

	Ctrl+Shift+T
	Shortcuts – displays a list of keyboard shortcuts.  Global shortcuts and shortcuts specific to the current page will be listed. 

	Alt+H, arrows
	Coding Manuals – Some of the SEER, NAACCR, FORDS, and Collaborative Staging coding manuals have been distributed with SEER*Abs and can be opened via the Help menu.

	Alt+H, arrows
	Version History – displays a dialogs showing the changes made to each release of the application

	Alt+H, arrows
	About – displays system information including the installed version and credits.


Status Bar
A status bar is shown at the bottom of the screen.  The contents of the status bar are described below.  

· Your username and the current facility are displayed on the left side of the status bar.  The facility will be used as the default for filters and some fields when entering data.  If you need to change the facility, select File > Set Current Facility.

· The name of the current module is shown on the far right side of the status bar.  In the example below, the user is viewing the Worklist and FAC-0010 is the Current Facility.
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· You may move back and forth from the record editor to other parts of the system without closing the record.  If a record is open in the editor:

· The center part of the status bar contains the edit failure for the current file (if any edit is failing for it).

· The type of record is indicated by an ID prefix or the full record ID.  If the record has never been saved, only the prefix is shown.  ABS is the ID prefix for abstract records.    

· Mod is displayed if the record has been modified but not saved.

· The number of failing edits will be shown in parentheses. 

· The current status of the record is also displayed.

· The figure below shows the status bar as it would be displayed while editing an abstract record that was saved and then modified.  The modifications have not been saved.  The (2) indicates that there are two edits failing for the record.
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Keyboard Commands

To access a menu using your keyboard, press Alt + a letter.  To view the letter assigned to each menu, only press the Alt key.  A single letter will be underlined in each menu item.  Alt + that letter will open the menu.  You may then use arrow keys or the key combinations listed on the menu to access a specific menu item.  

In addition to the shortcuts listed in the menus and toolbar icons, there may be shortcuts designed specifically for the current page.  Enter Ctrl+Shift+T to view a list of the currently available keyboard shortcuts.

User Preferences
To open the User Preferences dialog, click on the Preferences under the File menu.
The following parts of the application can be customized:

· Startup – Toolbar: whether the toolbar should display large icons, small icons or no icons at all. The F keys short still work even when the icons are not displayed (unless the F-keys have been re-assigned to record editor actions, see Key Binding). 
· Startup – Worklist: default filter for the worklist: display only the outstanding work, or all the records (and Abstract Facility Leads if they have been enabled in your Registry).
· Record Editor – Key Binding: this is the most complicated feature in the Preferences; it allows the 12 F-keys to be re-map to common action in the record editor like display the lookup for the current field, display the documentation for the current field, initiate a physician search, etc.. By default the F-Keys are used to access the main pages of the application (Worklist, Editor, Search and Synchronization).  If the F-keys are used for record editor actions instead, they won’t trigger the main pages anymore. In that case, the Alt+Left and Alt+Right can still be used to go to the next and previous main page. The figure on the next page shows the different option that can be assigned to the F-keys 
· Record Editor – Lookups: simple customizations for the lookups.
· Record Editor – Text Panel: whether the text panel (for large text fields) is shown by default when opening a record.  Note that not all record types support a text viewer; that depends on how your Registry configured the data entry forms.
· Record Editor – Info Panel: Whether the info panel (showing the record summary on the top of the page) is shown by default when opening a record. Note that not all record types support a record information panel; that depends on how your Registry configured the data entry forms.
· Record Editor – Font Size: the default font size to use in the record editor.
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Section 3:  Worklist

The SEER*Abs worklist displays tasks related to records (abstracts and possibly some other types if the application has been configured to support them) and Abstract Facility Leads (if they have been turned on in your Registry).  In SEER*Abs, an Abstract Facility Lead (AFL) is used to let an abstractor know that an abstract is needed.  An AFL is a request to abstract medical records for a patient at a specific hospital or facility.  The AFL may include data items describing the patient and case.  

AFL is an optional feature in SEER*Abs.   If used, the AFLs are loaded from registry data.  The AFLs are listed in the worklist.   You would open an AFL and review the information.  You could then create an abstract record from the AFL (some fields may be auto-filled using values in the AFL).  

In addition to AFL tasks, all records created in SEER*Abs are listed as tasks in the worklist.  It is possible to have tasks for each type of record supported in SEER*Abs including abstract records and records designed specifically for your registry.  The task ID includes a prefix which identifies the type of task.  The prefixes can be customized for your registry, if desired.  The prefixes used for tasks in the default version of SEER*Abs are:

· AFL – Abstract Facility Lead.  This “lead” indicates that an abstract is needed from a specific facility for the patient.  

· ABS – worklist task to finish an incomplete abstract record.

· There may be other types of tasks unique to your registry.
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The worklist filters and columns can be configured, the worklist in your version of SEER*Abs may not be exactly as shown above.  Typically, there will be filters at the top of the worklist that allow you to search for tasks by task type, status, facility, and other search fields.  The results of your search will be displayed in the table below.  When you first log in, the worklist will display the outstanding AFL tasks for the Current Facility.
Navigation Keys for the Worklist

If you prefer keyboard navigation to using the mouse, you may use the following keys to move through the worklist and make selections:

· Tab: press Tab to move from one filter to the next.  Tab will also take you from the last filter to the Reset button, and from the Reset button to the first task in the worklist.

· Shift+Tab: use this to move in the reverse direction as Tab

· Alt+Down: to view the choices in a drop-down menu

· Arrow keys: to scroll through the choices in a drop-down menu; or to scroll through the tasks in the worklist.

· Enter: If your cursor is on a filter, pressing Enter will start the search using the settings in all filters.  If your cursor is on the Reset button, the filters will be reset to their default values.  If your cursor is on a worklist task, the task will open.

Searching the Worklist

Search criteria are entered in filters displayed at the top of the worklist.  Your registry’s system administrator can configure SEER*Abs to show different filters or change the way that the searches are implemented.  The following describes the default configuration in the distribution version of SEER*Abs.
To search for tasks in the worklist:

1. Use the drop-down menu to select the Type of worklist task.

a. AFL – a request for an abstract from a specific facility.  Data identifying the patient and the cancer of interest are defined in the AFL. This type will not be shown if AFLs are turned off in your Registry.
b. Abstract and Other Types of Records – The worklist includes records entered in your installation of SEER*Abs. These include records that were entered but not completed, records that were completed but not submitted to the registry, and records that were submitted and archived.  Archived records are available in the worklist until they are purged using the Action > Purge Archived Data menu item.

c. Any – all of the above.  
2. Select the Status.  The values listed in the drop-down menu will vary based on the Type of task selected in step 1; you cannot filter by status if Type = Any.   Options that are enclosed in brackets are combinations of other values, for example <Outstanding> lists all open tasks for the selected data type; and <Any> lists tasks with any status for the selected data type.

The following are the statuses for AFLs and Records as defined in the default distribution.  The values may not be exactly what you see in your Registry. 
a. Default Statuses for AFL Tasks

i. Not Processed – have not started abstracting the case

ii. In Progress – began abstracting but did not complete the abstract

iii. Abstracted – created a complete abstract record for the case

iv. Not Abstracted – determined that the case should not be abstracted

v. Archived – submitted the results of the AFL to the registry.  The status of an AFL is set to Archived when you export the AFL data.  Archived AFLs are retained in SEER*Abs for a period of time that is defined in registry configuration settings.  Archived data that have expired can be removed by selecting Action > Purge Archived Data.

vi. Outstanding – AFL tasks that have a status of In Progress or Not Processed.

vii. Any – All of the above.

b. Default Statuses for Record Tasks

i. In Progress – entered some but not all data in the record

ii. Completed – entered all fields and marked the record as complete

iii. Archived – submitted the record to the registry.  The status of a completed record is set to Archived when the record is exported.  Archived records are retained in the system for a period of time as defined in registry configuration settings. 

iv. Outstanding – In Progress is the only outstanding status for records.

v. Any – All of the above.
3. If you are searching for tasks related to a particular facility, enter a value in the Facility filter:

a. If you know the facility’s ID, type the ID into the filter.  SEER*Abs Facility IDs are the same as those in your central registry’s data management system.  If your registry uses SEER*DMS, you do not have to enter the FAC- prefix.  Multiple IDs can be entered separated by commas.  You may press Enter to apply your changes to the facility filter or Tab to another filter to enter additional search criteria.

b. Or click the Lookup [image: image11.wmf] to search the database for the facility ID.  

i. Enter search text into the lookup’s filter.  The lookup table and its search feature are defined by registry configuration settings.  You may sort the table of search results by clicking a column header.  

ii. Double-click an entry to select it.  If you prefer to use keyboard controls:

1. Press tab to move from the text search box to the list.  

2. Use the arrow keys to move through the list.  

3. Press Enter to select an entry.

4. The Text box is a generic, Google-style search box that can be used to search for tasks based on fields displayed in the worklist.  Registry-defined configuration files determine which fields are searched.

5. Press Enter to apply the filter settings.

You may click Reset to return all filters to their default values and reload the worklist.

List of Tasks

The items that match the filter settings are displayed in a scrolling table just below the filters.  The columns displayed in this table are controlled by the configurations set by your registry staff.  SEER*Abs is shipped with the columns ID, last name, first name, middle initial, SSN, Medical Record Number, Facility, Last Modified, Linked Record/AFL, and Status.   The table can be sorted by clicking the column header of any column.  Click the column header a second time to reverse the sort order.

A message is printed above the worklist table on the left side that shows the number of items displayed.  A configuration parameter determines the maximum number that will be displayed in the worklist (500 is the default setting).  A message will be displayed if the number of results returned by your search exceeded the display limit.  

If your search exceeded the display limit and you are looking for a particular task, it may be missing from the items listed.  You should add more detailed search criteria in the filters.  For example, if you enter a common last name into the “Text” filter and the search results exceed the display limit then you should search by SSN, facility, medical record number, or other search criteria.
Contextual Menu for the Worklist Table

In addition to the Navigation keys, a contextual menu is available on the worklist when the right button of the mouse is clicked.  The following options are available:

· Open Selected Entity: opens the selected record or AFL; identical to double-click the corresponding row.  This option is enabled only if a single row is selected.

· Delete Selected Entities: deletes the selected records or AFLs; use the Ctrl key in combination with the mouse to select multiple rows. If the rows that need to be selected are together, then just select the first one with the mouse and drag down to the last one.

· Change Status of Selected Entities: changes the status of the selected entities.  A dialog shows the status of the selected entities, and the new status that should be assigned.

[image: image12.png]Change Status





· Copy Cell to Clipboard: copies the content of the current cell to the clipboard.  The content of the clipboard can then be copied into other applications.

· Copy Row to Clipboard: copies the content of the current row to the clipboard (fields are comma-separated).  The content of the clipboard can then be copied into other applications.

· Copy Table to Clipboard: copies the content of the entire table into the clipboard (one line per row, fields are comma-separated).  The content of the clipboard can then be copied into other applications.
Processing an AFL

To open and process and AFL in the worklist: 
1. Open the Worklist. (Click the Worklist toolbar icon, select Show > Worklist or press F1.)

2. Use the filters to search for AFLs from a particular facility or for a specific patient (see the Searching the Worklist section of this chapter).  
3. Use your mouse or keyboard controls to select an AFL (see the Navigation Keys for the Worklist section of this chapter).

4. Double-click anywhere on the AFL’s row or press Enter to open it.
5. The AFL will be displayed in a pop-up.  The layout of this screen is defined by your registry’s configuration settings.  The snapshot below is based on the configuration shipped with SEER*Abs.  
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6. Review the AFL and determine the appropriate action.  The Abstract button is selected, by default, when the AFL is first opened.  Use tab or your mouse to move from one button to the next. 
a. To abstract the case, press Enter or click Abstract.  SEER*Abs will open the abstract editor.  Data from the AFL and your abstractor ID may be auto-loaded into the record fields, as defined in your registry’s configuration settings.  Instructions for entering and saving the record data are provided in the Editing a Record section of this document.

b. If an abstract is not appropriate for this case, use your keyboard or mouse to select Not Abstract.  

i. Type a value or use the lookup to specify the Reason Not Abstracted.  

ii. Provide information specific to the case in the Detailed Explanation section.

iii. Click Update AFL Status to save these changes.
c. Search – Takes you to the Search module with the filters set for the patient described in this AFL.  If your registry uses reference data, this allows you to see if your registry has any information about this patient already.
d. Cancel – exit the AFL without saving any changes.

Opening a Record in the Worklist
To open a Record from the worklist in order to complete or review it:

1. Open the Worklist. (Click the Worklist toolbar icon, select Show > Worklist or press F1.)

2. Use the filters to search for the record as described in the Searching the Worklist section of this chapter.  
3. Use your mouse or keyboard controls to select a record (see the Navigation Keys for the Worklist section of this chapter for more information).  

4. Double-click or press Enter to open it.  

5. The record will be displayed in the editor.  Instructions for entering and saving the record data are provided in the Editing a Record section of this document. The editor might not be editable if the record has already been extracted out of SEER*Abs.

Section 4:  Editing a Record

The SEER*Abs Editor allows you to create or modify records.

To create or modify a record:
1. Open a record in the SEER*Abs Editor using one of these methods:

a. Abstract records may be created while completing an AFL worklist task as described in the Processing an AFL instructions provided in Section 3: Worklist.

b. Or you may create a new record by selecting New Abstract or New <other record type> from the File menu.

c. Saved records can be opened via the worklist as discussed in Section 3: Worklist.
d. Or you may go directly to the SEER*Abs editor by pressing F2, using the toolbar icon, or by selecting Show > Editor.   To open a record in the editor:

i. If you would like to create a new record, click the button corresponding to the type of record that you wish to create (Abstract or a record defined specifically for your registry).

ii. If you would like to re-open a record that you were working on recently, select it from the Recent Records list.  The last 25 records that were modified in the Editor will be listed.  Records listed with an asterisk are In Progress.

2. Enter data into the fields.  Refer to the subsequent sections of this chapter for an overview of the editor and descriptions of the controls and features.  

3. Registry-defined edits, system edits, and edit packages such as the SEER Edits may be integrated into SEER*Abs.   Edits are described in detail in the Edits to Validate Data section of this chapter.  To apply edits as you enter data:

a. Configuration settings determine whether edits are executed as you move from one field or tab to another.  If edits do not execute as you move from field to field, you may click Validate to execute edits for all fields.  

b. To display a list of all edits failing for the record, click Show Errors.  The edits will be listed in the Message pane at the bottom of your screen.

4. Options for exiting and/or saving changes while editing a record:

a. Save will save changes made in the current session.  The current values in the record will be written to the SEER*Abs main database.  The record will remain open in the record editor and the record’s status (In Progress or Completed) will not be altered.

b. Complete will save your changes, flag the record as a completed record, and close the record display.

c. Close will close the record display.  If you have made changes that have not been saved, you will be asked if you want to save those changes.  The record’s status will not be altered. 

d. You can actually navigate to any part of the system while you are editing a record.  The record will remain open in the editor.  The status bar will indicate the type of record, whether there are unsaved changes, and if the record has failing edits.  If you exit SEER*Abs you will be notified if unsaved modifications have been made to the record.

Records can be opened and modified until they are exported (status = archived); you cannot modify data once it has been archived and you cannot use SEER*Abs to modify records that were created by other software.  Archived records can be viewed in the editor in read only mode.  Archived records are completely removed from the SEER*Abs database when the Purge Archived Data action is used.  It is possible to modify the status of a record to recover from a mistake.
To modify the status of a record:
1. Select the record in the worklist by clicking one on its row.

2. Right click that row to display the context menu.

3. Select the option Change Status of Selected Entities.

4. In the option dialog, select the new status for the record.

5. Click OK.

This operation should be used with care; the record statuses define the workflow of the records, modifying them through this mechanism override the normal workflow.  It is not something that should be done on a regular basis.

Accessing the Record Editor

If no record is open, a page is displayed that shows a summary of record counts and allows you to create a record.  This page can be customized.  The screen shot below shows the default page, it might look slightly different in your registry depending on your customized configuration.
The top left section is the Create New Record section.  It contains a button for each record type that can be created with the application.  By default only Abstract records can be created, but the application can be customized to support other Registry-specific types.

Under that section is the Recent Records section.  The last 25 records that were opened are listed in that section; double-click a record to open it.  If a record as an asterisk after its label, it means it is still in progress.

The right side of the page provides Records Counts. The entire section is fully customizable by your Registry; the default version shows counts for the Abstract records split by their status, for the current year, the previous year, and all the years together.
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Record Data Entry Form

SEER*Abs has default screen layouts for abstract records.  Other types of records can be defined by your registry’s system administrator.  All record layouts can be customized by staff at your registry.  If you experience any problems or would like adjustments, please contact your registry’s SEER*Abs system administrator.  The screen shot below is of an abstract record using the default layout shipped with SEER*Abs.

The next screenshot shows the default data entry form for Abstract records.  It is composed of the following elements:

· A toolbar is displayed on the very top.  

· Under the toolbar is the record’s summary panel.  Whether that panel is shown, and which fields are shown in the panel can be configured differently for each Registry.

· On the right-side of the screen is the text viewer used to display a read-only version of the large text fields. Whether the text viewer is shown, and which fields are shown in its panel can be configured differently for each Registry.  

· The rest of the screen is the data entry form for the current record.
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The record type is shown on the right side of the status bar (ABS in the example above).  The full record ID is displayed only if the record has been saved.  A complete description of the status bar is provided in Section 2: Introduction to SEER*Abs.
Record Editor Toolbar

	Icon
	Shortcut
	Description
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	Ctrl+S
	Save the current record.
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	Ctrl+O
	Complete and close the current record.  Only completed records can be extracted.
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	Ctrl+D
	Close the current record.  If it contains unsaved changes, a confirmation dialog will be displayed.
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	Ctrl+D
	Delete the current record.
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	Create a new record based on the value of the current record.  The current record will be closed.  If it contains unsaved changes, a confirmation dialog will be displayed.  Not all records can create other records; this option might be disabled for some record types.
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	Ctrl+T
	Validates the current record.  Although that behavior can be customized differently in your registry, the form is also validated every time a field looses focus.
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	Ctrl+R
	Display the failing edits at the bottom of the page.
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	Ctrl+Minus
	Decrease the font size of the editor.  The default font size to use can be changed in the User Preferences dialog.
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	Ctrl+Zero
	Reset the font size of the editor.  The default font size to use can be changed in the User Preferences dialog.
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	Ctrl+Plus
	Increase the font size of the editor.  The default font size to use can be changed in the User Preferences dialog.

	
[image: image26.png]



	Ctrl+<
	Display only the text viewer (hiding the data entry form).  The default behavior of the text viewer can be changed in the User Preferences dialog.  Note all the record types support a text viewer and this option might be disabled.
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	Ctrl+\
	Display both the text viewer and the data entry form.  The amount of space used by the text viewer can be changed by dragging the separation between the data entry form and the text viewer panel.  The default behavior of the text viewer can be changed in the User Preferences dialog.  Note all the record types support a text viewer and this option might be disabled.
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	Ctrl+>
	Display only the data entry form (hiding the text viewer).  The default behavior of the text viewer can be changed in the User Preferences dialog.  Note all the record types support a text viewer and this option might be disabled.

	
[image: image29.png]



	Ctrl+?
	Toggles the location of the text viewer between right side of the data entry form and bottom side.  The default behavior of the text viewer can be changed in the User Preferences dialog.  Note all the record types support a text viewer and this option might be disabled.
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	Hide the record summary panel.  The default behavior of the summary panel can be changed in the User Preferences dialog.  Note all the record types support a record summary panel and this option might be disabled.
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	Display the Multiple Primary Calculator tool.
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	Display the ICD Codes Lists tool.


Color Codes Used in the Record Editor
The SEER*Abs record editor displays data fields in different colors to highlight fields that contain errors and fields that have been modified but not saved.    

	Colored Field
	Description
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	White indicates that the field does not have an error and has not been changed since the last save.
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	A dark red indicates that the field is failing a system edit. The error message is displayed when you mouse-over the field.
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	A lighter red indicates that the field is failing an edit defined in the configuration files. The message is displayed when you mouse-over the field.
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	Yellow indicates that the field has been changed.  The record has not been saved since the change was made.
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	The field is shaded in green to indicate the current location of your cursor. 
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	Gray indicates that the field is read-only.  Read-only fields are skipped when tabbing during a data entry session.
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	A combined shaded of gray and green is used to indicate that a read-only field has focus.  You are allowed to select a read-only field so that you can copy-and-paste the value of the field.


Entering Values into Data Fields 

To enter values into data fields:

· You will be able to type values directly into most fields.  

· Some fields will be auto-filled with default values based on your registry’s scripts.  The scripts will determine whether you can over-ride those values or not.

· Fields with light bulbs [image: image40.wmf] have a lookup table associated with them.   The lookup tables are defined in registry configuration files.
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· Click the light bulb  [image: image42.wmf] , press Ctrl+L or use the right-click contextual menu to open the lookup.

· Enter search text.  You may search for a code or for descriptive text.

· If you press Enter while entering search text, your search text will be copied into the field.  This is useful if you enter a code and use the lookup to confirm its meaning.

· To select a value from the list using keyboard controls, press Tab or Ctrl + Down to move your cursor to the list and the arrow keys to move through the list.  Press Enter on the highlighted row or double-click an entry to select the value.

· For some fields, the value may only be changed by modifying a related field.  For example, the figure below shows the ID and name of the Managing Physician.  You may enter a value into the ID field by typing the value or by using the lookup.  The name field is read only and will be auto-filled based on the ID. 

[image: image43.png]Managng Physcan [s28-01205 |Q [Bndezsen, Eiizanech





· If auto-forwarding is enabled, the cursor will automatically advance to the next field when you enter the number of characters equal to the field’s length.  (Field length is the maximum number of characters that can be entered and may differ from the size of the box on the screen.)  If auto-forwarding is on, you should only need to use tab to move out of fields that vary in length, for example, name, address, and text fields.  
· The cursor will not move forward if you enter a value that triggers a System edit.  A system edit fails when the value does not match the data type of the field (letters in a numeric field, for example).   The system will beep and your cursor will stay in the field.  You can either enter a valid value or press Tab a second time to move your cursor forward.

· If edits do not execute as you move from field to field, click Validate to execute edits for all fields.  The edits are controlled by a configuration setting.  The edits may be set to execute as you move from one field to another; or the edits may be suppressed until you move to another tab or click Validate. 

Field Descriptions

Coding information and other descriptive text can be associated with fields.  Descriptions from the NAACCR coding manuals are included by default for NAACCR items.  Registry staff may configure SEER*Abs to display descriptions for registry-specific fields.  If a description is available, the field label will be underlined when you mouse-over the label.  Click the label, press CTRL-N or use the right-click contextual menu when editing a field to display the description.
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Autocomplete Feature

While entering text in a field, you may press Ctrl+Space to use the autocomplete feature.  SEER*Abs will search a list of terms based on the current word that you are typing.
When using the autocomplete feature, you may:

· Continue typing until there is a single term in the list.  Press Enter.   This is useful for confirming spelling or syntax.

· Or when you see the term in the list, press Tab to move your cursor to the list itself.  Scroll through the list using the arrow keys.  When the term is highlighted, press Enter.

· If you enter text that is not in the list, enter a complete term and press Enter.  The value of the field will be set to the text that you entered.   You may want to ask your registry’s SEER*Abs system administrator to add missing terms to the autocomplete list.
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SEER*Abs supports multiple sets of autocomplete terms.  Separate lists may be designated for different fields, for example, there may be one list for histology and another for primary site.  Or terms from all lists may be made available in a field, for example, all terms are typically made available when editing large text fields.

Multi-lines text boxes

Some fields can support multiple lines of text as shown below.
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Pressing Enter in a multi-line field will add a line break and your cursor will stay within the field.  To enter a significant amount of text into a field, press CTRL+E or use the right-click contextual menu to open a larger text editor.

[image: image47.png]



The autocompletion feature (CTRL+Space) can be used when entering text in the expanded text editor.  Click OK to close the dialog and apply the new text to the field, or Cancel to close the dialog and leave the field as-is.

The number of characters per text field is limited by configuration settings.  If you enter more than the maximum allowed, an error message will be displayed at the bottom of the expanded text window.

Physician and Facility Lookups

The facility and physician lookups are associated with search dialogs similar to the one shown below.  The physician and facility lookup have a Simple and Advanced search tabs.  The Simple Search tab has a single search field that is matched against multiple fields (a Google-style search).  The Advanced search tab has multiple fields to filter the list.

The Simple Search tab is configurable.  Your registry’s system administrator can change the configuration and control which fields are presented in the table, which fields are used in the Simple Search, and the type of searching algorithm that is used (exact, contains, fuzzy, or a lookup).  To use the Simple Search, type a search string into the Text box and press Enter or click Search.  Click Reset to clear the search string from the Text box.
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If you see the result you are interested in, type Ctrl+Down to move the focus from the search field to the table of results, use the down key to go on the correct row and type Enter.  You can also double-click the row.

Note that the different fields that are searched from the Simple Search tab are “ORed” together. The results are always sorted by relevance to the criteria, which the most relevant result shown first in the table.

If the simple search is not enough, press Ctrl+Tab or use your mouse to move to the Advanced Search tab.  Components of the Advanced Search are also configurable.  The registry’s configuration determines which fields are available for searching and the type of search algorithm used for each field.
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Note that the different search fields of the advanced search are “ANDed” together.  The results are always sorted by relevance to the criteria, which the most relevant result shown first in the table.

If you prefer keyboard navigation to using the mouse, click Ctrl+Shift+T to view the shortcuts that are specific to the physician and facility lookup.

	Ctrl+Down
	Move the cursor to the table of search results

	Ctrl+Q
	Close current Window

	Ctrl+R
	Reset the search criteria (clear search Text box or filters)

	Ctrl+S
	Start the search

	Ctrl+Tab
	Switch between Simple and Advanced search tabs

	Enter
	If your cursor is in the top section with the search criteria, enter starts the search.  If your cursor is on one of the search results, it sets the field to the ID selected.

	Escape
	Close the current Window

	Shift+Tab
	In the advanced search, go to previous field.

	Tab
	In the advanced search filter, go to the next field.


Collaborative Stage Lookups
The default data entry form contains the 25 CSv2 fields with their corresponding lookups, although the fields are hidden by default, until a site and histology are provided allowing the determination of a valid Collaborative Stage schema.
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Once a valid schema is provided (for example LipLower for C001/8000), the SEER required factors are displayed and the labels are dynamically update:
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The labels starting with [REQ] are the SEER required site-specific factors for that particular schema, you may use the “Show All Factors” button to display all the fields.
The content of the lookups change dynamically.  SEER*Abs utilizes the CSv2 software developed by the Collaborative Staging Task Force (cancerstaging.org) to create the content.
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The following features are displayed in the collaborative stage lookups:
· Search box.  You may search on the code or any text in the table.  To select a value once you have completed your search:
· If you have entered a valid code in the search box, press Enter.   Text in the search box will be copied into the field (do not use enter if you type descriptive search text instead of a code).
· To move your cursor to the table, press Ctrl + Down.  You can then scroll through the table entries.  Press enter to select. 

· All shortcuts can be displayed by pressing Ctrl+Shift+T.

· The site and histology for site-specific surgery, schema for the collaborative stage fields, field name, and field description.

· Site and histology – In the site-specific surgery lookup, the site and histology are displayed in the title bar of the popup.

· Schema – The CSv2 schema name is displayed as a title in the lookups for collaborative stage fields.  In the example above, “Breast” is the schema.

· Field name and description – In the example above, the name is CS Site-Specific Factor 1 and the description is ‘Estrogen Receptor Assay (ERA)’.   The field names and descriptions of the collaborative stage fields are returned by the CSv2 software and are not configurable.   Descriptions are not available for all CSv2 fields.
· A section with the code and corresponding description; and a separate section of notes.  You may use the icons at the top right of the window or keyboard shortcuts to control the display:
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· To hide notes:  Use the rightmost icon that shows the right side of a book or press Ctrl + Right Arrow.

· To show both notes and codes side-by-side:  Use the middle “open book” icon or press Ctrl + Up Arrow.

· To show notes only:  Use the leftmost icon that shows the left side of a book or press Ctrl + Left Arrow.

· You may also drag the center bar to adjust the size.
The default behavior of the Collaborative Stage lookups can be customized in the User Preferences dialog.

Site-specific surgery lookup

Some fields might also be attached to a special site-specific lookup.  Like the Collaborative Stage lookups, its content is dynamically created once a valid site and histology have been provided.
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The features of the Site-specific Surgery lookup are identical to one for the Collaborative Stage lookups.  Note that this lookup contains empty lines and comment lines (in blue); those cannot be double-clicked to assign a value to the corresponding field (since they do not correspond to any value).

The default behavior of the Site-specific Surgery lookup can be customized in the User Preferences dialog.
Edits to Validate Data

Registry-defined edits, system edits, and edit packages such as the SEER Edits may be used to validate fields while entering data.  Failing edits do not prevent the record from being saved, completed, or closed.  When a field triggers an edit, the field is shown in red and the edit failure message is shown in the status bar if the field is focused.  The error message will also be displayed if you place your mouse over the field.  Only one message is displayed if multiple edits are failing for the field.  All edits failing on the record are shown in the failing edits tables at the bottom of the screen (the Show Errors button toggles the display of the table; by default it is not displayed).

There are two types of edits, internal system edits and edits defined in the configuration files.

· System Edits:  Indicates that the value does not conform to database or system rules.  For example, the value may be an incorrect data type for the field (a letter in a numeric field) or the value may not be in the field’s lookup.  Configuration settings determine whether a field can have a value that is not in the lookup.  If a system edit fails, SEER*Abs will beep and not move your cursor forward (correct the value or press Tab a second time to move forward).  Examples of system edits:

· a numeric field contains characters that are not digits

· a Boolean field contains a value other than “0” or “1”

· a date field is not in the “mm/dd/yyyy” format

· a field contains a physician or facility ID that does not exist in the SEER*Abs physician or facility lists.

· a field associated with a lookup contains a value that is not in the lookup table (and the configuration for the field requires a value in the lookup)

· Edits included in your registry’s configuration: These include edits defined by registry staff, SEER Edits, and other edit packages that may be integrated into SEER*Abs.  SEER Edits are distributed with SEER*Abs, but are turned off in the default configuration.  

A field is highlighted in dark red if it fails a system edit.  A lighter shade of red is used for fields failing configuration edit.  The following screenshot shows a system edit failing on the field “Race 4” because the value “XX” is not in its lookup; and a SEER*Abs edit failing for the Maiden name, notice how the sex field is also in red because both fields are involved in the edit.
[image: image55.png]8 SeR Abstracting Tool I

Fie Show Acion Help

By @lX Hi BB Q%

D@ E B v

ook [ 3

Last: DEPRY _First: FABIAN DOB: 01/01/2000 SSN: 123456789 Fac: FAC000051 DX:01/01/2012 Site: C001 _Morph: 8000/3
Demographics (3) | Tumor | staging | summary T | HospitalTx | DxText | path JumptoField | <SelectField>
Staging (select | edit) il
PatD pre Last [pzRy Frst [zam1an n e e e
| o [ - Lozen Tpmum s ssemty cummy cexs ot
- the printing sna cypesecsing
Race 01 |Q[ee Q rtace[ | Q Bethot[ox |/[oz |/[z000 o e e ||
induscry's scandard dummy cext ever
Follow-up = || |-tnce cne 15005, wnen an unknown
printer took a galley of type and
ootc|az |/[ox |1[z012 | vialstans [ ]Q Autopsy [ |Q surv cuaity[ |0 =crambled it to maks a type specimen
book. It has survived mot enly five
Fusoce| |Q Nextrusec[ |Q semTyperu[ |Q Fusccnt| |Q centuries, but slso the lesp into
electzonic cypesstting, remaining
Folow Reg NP1 Folow Reg essentially unchanged. It was
popularized in the 1360s with the
DCFie Deathpace[ |Q cop covrev#[ |0 zelesse of Lecraser shests
containing Loren Tpsun passages, and
rore zecencly with desksop
e T publishing sofoware like Aldus
Pageliakes including versions of
Num pre[ | sweet Ty Q post|_|Q suenl Lorem Tpsum.
&l 0 see[ ]Q 2 Gy o Remarks (select | edt)
Current Address K P ——
—— = =
< J y || search (mEm] oeta]
» Group. Message
EDIT-001 | SEER®Abs | Maiden name provided, sex must be 2 (FEMALE)
FeldRace 4 System  Value & notin corresponding lookup
Logged in as depryf at FAC-000051 (Testing Hospital) ABS-000001 : Mod (2) - INPROGRESS | Showing Editor





To view a list of all edits failing for the record, click Toggle Errors View button.  This button is a toggle to show or hide the error panel at the bottom of the screen.  The error panel shows the Edit ID, Group, and Message for each edit that is failing.  Double-click a row to open the Edit Information dialog for that particular edit.  

The number of edits failing in the record is displayed on the right side of the status bar.  If your record layout uses a tabbed interface, the number of fields failing edits is shown next to the tab name.  In the example, 3 fields are related to failing edits.  Maiden name and sex are related to EDIT-001; and Race 4 is related to the Field Race 4 edit.  In this example, there are 3 fields related to 2 edits that are failing for the record.

To view more information about a failing edit:
· Use the Ctrl+P shortcut
· Right-click on the field to bring up the contextual menu and select the View Failing Edit Info option

· If the failing edits are displayed at the bottom of the page, you can double-click a given row.

The Edit Information dialog shows the documentation for the current edit; it also contains other data like the edit’s history, code, dependencies, etc…  The following screenshot shows the documentation of a SEER edit, pure SEER*Abs edits usually have less documentation available.
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Text Viewer

The Text Viewer allows you to view text fields while coding other fields.  The Text Viewer is a read only panel within the editing window.  The Text Viewer stays on the screen when you switch from one data tab to another.  Your registry’s configuration defines the fields shown in the Text Viewer.  The viewer was designed for the display of large text fields, but any field may be shown in the viewer.

Use Jump To Field to view a specific field in the Text Viewer.   The scrollbar will adjust so that the selected field is shown at the top of the panel.    

To find text in any field, enter text in the Search box and click Go.   The Text Viewer will adjust to show the first occurrence of the term.   Click Go again to search for the next occurrence.  Click Clear to reset the search box.   

There are some very specific shortcuts for the text viewer; those can be viewed by using Ctrl+Shift+T:

· Ctrl+<: show only the text viewer (hide the editor).

· Ctrl+>: show only the editor (hide the text viewer).

· Ctrl+\: show both the editor and the text viewer.

· Ctrl+?: toggle text viewer location between right side and bottom side.

· Ctrl+J: Jump to a particular text box in the text viewer.

· Ctrl+F: Initiate a search in the text viewer.

· Ctrl+K: Search the text boxes with the current search text.

· Ctrl+M: Clear the current search.

· Ctrl+H: Sets the focus on the record editor.
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Record Summary Panel

The record summary panel shows the value of key fields for the current record.  It is displayed on the top of the editor.  Not all record types support this feature.
When a record is opened for the first time, the panel will only show the labels.
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The value will appear as the data entry form is populated.
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The panel can be hidden using the Toggle Info View icons in the toolbar.
The behavior of the panel can also be customized in the User Preferences dialog.

HematoDB Multiple Primaries Calculator Tool
The Multiple Primaries Calculator is the last step of a more complex procedure to identify multiple primaries.  Please refer to the Hematopoietic Manual for more information. 
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To use the Multiple Primaries Calculator:
1. Enter two histology codes with or without the behavior (so “8000” or “8000/3”).

2. Click the Calculate button or type Enter.
HematoDB ICD Codes Tool

The ICD Codes Lists shows the different ICD-O-3 codes related to Hematopoietic and Lymphoid diseases with their names, alternate names and corresponding ICD-10 and ICD-9 codes.
The view can be toggled to view the codes by ICD-O-3, by ICD-10 or by ICD-9.

To search of a term:

1. Type the term in the Search text box.

2. Type Enter or click the Search button.

3. Only the row containing that term are retained in the table, and the term is displayed in red everywhere it is found.

To reset the search and display all the rows again, click the Reset button.

It is also possible to view more information about a particular code by double-clicking its row.  This will automatically open the Search page and initiate a search in the Hematopoietic and Lymphoid database.
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Creating a Record from another Record 

You may create a new record based on an existing record.  You will be able to auto-fill selected fields by copying values from the current record into the new record.  This was primarily designed for creating an abstract record from a casefinding record, but it can be used to create a second abstract record to reduce data entry for multiple primaries.

To create a record from another record:

1. Open an existing record in the SEER*Abs Editor.   This will be referred to as the “original” record in these instructions.

2. Click Copy.
3. If there are unsaved changes, you will be asked if you would like to save them.

4. Select the record type for the new record.

5. If you are creating an abstract from an abstract, you may copy all data or sections of data from the original record into the new abstract.  A dialog like the one shown below will be displayed.  Select the sections of data that you would like to have copied from the original record into the new abstract.   The copy feature is a configurable feature in the scripts for creating records.  The registry’s system administrator must ensure that the appropriate elements are copied.
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Keyboard Shortcuts
In addition to the global shortcuts, there are several shortcuts specific to editing record data.  Press CTRL+Shift+T to view the Shortcut Help.

	Key Command
	Action

	Ctrl+D
	Delete the record currently being edited.  This is the same as clicking Delete.                                                                                                                                                                                

	Ctrl+Down Arrow


	Go to next row in the editor.  From the last row on a tab, this goes to the first row in the next tab.  From the last row on the last tab, this goes to the first row on the first tab.                                                                                                                                                                                                                      

	Ctrl+E

	Display the Expanded text window for a multi-line field.                                                                                                                                                                                                                                                                                                                                                          

	Ctrl+L          
	Display the field lookup if one is defined for the current field. It is the same as clicking the light bulb.                                                                                                                                                                                                                                                                                                        

	Ctrl+Left Arrow  
	Go to the previous field in the row.  From the first field in the row, this goes to the last field in the previous row.  This will also move across tabs.  Same as Shift+Tab.             

	Ctrl+N
	Display documentation for the current field, if available.

	Ctrl+O           
	Save the record currently being edited.  Change the status to Completed.  Close the record.  This is the same as clicking Complete.                                                                                                                                                                                                                                                                               

	Ctrl+Q           
	Close the record currently being edited without saving.  Same as clicking Close.                                                                                                                                                                                                                                                                                                                     

	Ctrl+R           
	Switch between viewing and hiding the edit errors.  Same as Show/Hide Errors.                                                                                                                                                                                                                                                                                                              

	Ctrl+Right Arrow 
	Go to the next field in the row.  From the last field in the row, this goes to the first field in the next row.  From the last field in the last row on the tab, this goes to the first field in the first row on the next tab.  From the last field in the last row on the last tab, this goes to the first field in the first row on the first tab.  This works the same as Tab.                          

	Ctrl+S           
	Save the record currently being edited.  This is the same as clicking Save.                                                                                                                                                                                                                                                                                                                                     

	Ctrl+Shift+Tab   
	Go to the previous page.  From the first page, this goes to the last.                                                                                                                                                                                                                                                                                                                                      

	Ctrl+T           
	Validate the record currently being edited (force the edits to be recalculated).  This is the same as clicking Validate.                                                                                                                                                                                                                                                                                       

	Ctrl+Tab         
	Go to the next page.  From the last page, this goes to the first.                                                                                                                                                                                                                                                                                                                                        

	Ctrl+Up Arrow    
	Go to the previous row in the record editor.  From the first row on a tab, this goes to the last row in the previous tab.   This works across tabs.                                                                                                                                                                                                 

	Enter            
	Go to the next field.  For multi-line fields, add a new line in the current field.  This is similar to tabbing out of the field except when in a multi-line field.                                                                                                                                                                                                                                           

	Shift+Tab        
	Go to the previous field in the row.  From the first field in the row, this goes to the last field in the previous row.  This will also move across tabs.  Same as Ctrl+Left arrow. 

	Tab              
	Go to the next field in the row.   From the last field in the row, this goes to the first field in the next row.  This will also move across tabs.  Same as Ctrl+Right arrow.              


Section 5:  Searching the Reference Data

The SEER*Abs Search page allows you to search patients and records reference data, facilities, physicians, SEER*Rx drugs and Hematopoietic and Lymphoid diseases.  
Reference data are transferred from registry data via the synchronization module.  Scripts maintained in the registry’s configuration define the amount and type of data that are made available as a reference.  These scripts can be configured to load the data directly from the registry’s database during synchronization; or the data can be loaded from external files.  Your registry’s system administrator will provide you with instructions for updating the reference data.

The Search page consists of five tabs with tab-specific filters at the top of the page.  As is true throughout SEER*Abs, the columns and filters are defined by registry configuration settings.  SEER*Abs is shipped with the filters and columns shown in the snapshots used in this manual.

To search for reference data:

1. Go to the Search Page using one of these methods:

a. To go to a specific tab and clear all filters:

i. Patient Data tab:  Select File > Search Patient Data or press Ctrl+Shift+P 

ii. Facility tab:  Select File > Search Facilities or press Ctrl+Shift+F 

iii. Physicians tab:  Select File > Search Physicians or press Ctrl+Shift+Y 

iv. SEER*Rx Drugs tab: Select File > SEER*Rx or press Ctrl+Shift+D
v. Hematopoietic and Lymphoid Database: Select File > Hematopoietic Database or press Ctrl+Shift+I
b. Or press F3 to return to the Search page from any part of the system.  The previously used filter settings will be restored.

2. Enter values in the filters at the top of the page.  For the Patient Data, Facilities and Physicians, your registry’s configuration determines which fields are available as filters, the type of search algorithm used for each filter, and the columns displayed in the search results.  The SEER*Rx Drugs and Hematopoietic and Lymphoid Diseases have a single “Google-style” search field.
3. Click Search or press Enter to apply the filters.

4. If you need to cancel a search, press Escape.   If searches are excessively slow, please contact your registry’s system administrator for technical support. 

5. For the Patient Data, Facilities and Physicians, you can double click an entry or use keyboard controls to view data for an individual record, patient set, facility, or physician.  The keyboard controls are described below:

a. Press Tab to move your cursor to the results table.

b. Use the up and down arrows to move your cursor to a specific item in the table.

c. Press Enter to open the data item.
6. If you open a data item, the data will be displayed using a screen layout defined in the registry configuration settings.   Reference data are displayed in read only mode.   Click the Close button at the top right of the page to close the window.

7. Click Reset to reset the filter values to blank.
Search results matching your filters will be shown in the table.  The total number of results is displayed just above the table.  If you exceed the maximum number of allowed results, the message “(maximum number of results was reached)” will follow that number.

The results are initially sorted based on a matching score.  You can sort by another column by clicking the column header; click it again to change from ascending to descending order.   Clicking Search or Clear will reset the sort order to be based on score.
Patient Reference Data
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The Patient Data tab can be used to search for records and consolidated patient data loaded from registry data.  These may include any types of records (abstracts, pathology reports, etc).  Typically, reference records only include records that have not been consolidated with other patient data in the registry’s main database.  The consolidated patient data are represented as “patient sets”.  These are data that have been consolidated from abstracts, casefinding, pathology, and other records submitted to the registry.    
Facility and Physician Reference Data
The Facility and Physician search tabs can be used to search for data loaded from registry data.  These are typically the same facilities and physicians are available in lookups; and the same fields may be available in both the reference data search and lookups.  However, registry configuration settings control the reference search tabs and lookups.   It is possible that certain criteria will be used to exclude physicians or facilities from lookups (for example, inactive facilities might be excluded).   Registry configuration settings also determine the fields shown in both the reference data search and lookup.

The screenshot below shows the default Facility search tab.  No search criteria are provided, so all the available facilities are displayed.
[image: image64.png]) SEER Abstracting Tool

File Show Action Help
Patient Data Facilities Physicians SEER™Rx Hematopoietic and Lymphoid Database
Name e <] wer ™ Adcress D

| Resits: 51

| ™ Name Type NPT FIN Address. Gty State
FACIG01 ] AUDRIANI AVELVEOMER Other Facity Other Facity 8451117710 072365264 43456 CUHAIMOR ARSHNICK Street ARTUS Gity "
FAC002 | DHAR BRADI Hospital Fosia | 5168331272 SO77673215 | 64082 ARIVRALDIL DULE Street DARGATOGHy | MD
FAC003 | ALHAPO BESESTAN Other Facity Other Facity | 8571866101 | 3603614125 | 52464 BERI DALIN Street DORTROLANGHy | MD
FAC004 | BARCYN ANDAIVENOR Lab b 1456451914 | 4672233428 | 33854 ARDER DULKYARGOR Street oGy | WD

|| FAco05 | ALRGASS CDEGAN Rad Therapy Unt Rad Therapy Unit| 12466649608 | 2676246703 | 30315 BISIRAH AGUILAC Street BESESTANGy | MD

||| Facoos  Brvorr comriGass inic Gric | 1927249513 | 3651312883 01586 BISPERON CERIVERIM Street ANOWwGty | M

|| FAC007 | AVAGORA AINIOMNU Nursing Home. NursingHome | 4022506763 | 6252046341 | 75562 AIST DHAR Sireet DARAIGGY | MD
FACO08 | ARAVIV ARLI Organization Organization | 5307262256 7641766073 | 35850 BELEERON ARIS Srest ANOWNUGy | MD
FAC009 | ALABHEL DATRODDYN Doctor Ofice Doctor Offce | 4547235627 | 6110220420 | 2303 ADRIST ANATH Street cammocy | Wb w71

|| Facow | camavii cim Hospita Fosial | 612649631 6766226070 | 01728 BISPERON BABRON Sreet DERCISRINGYy | MD | 67200

|| FACOIL | AVELER AVIROSCHK Medica Examiner | MedicalExaminer | 6142243%2 | 0404311383 | 11126 DAHRAIG AIDORAOL Street AVSsA Gty w0161
FACO12 | DOROLASIRE GHINTANN Hospice Hosice | 1581027265 | 0860246253 14244 AYARONN AMAS Street BRIDANTHGYy | MD 01304
FACOL3 | ARADI CEDSTLIMO Nursing Home NursingHome | 0877252216 | 7237461776 | 34173 CAEM CLDREYGO Street scaGy | WD 63w | |
FAC14 | BELEBRON DYMAR Docor Offce Doctor Offce | 8418632478 | 2177783165 | 42506 DINDRINSON CAEVE Sireet bovREsCly | MD | 2163
FACOL5 | DIATIVOS CHIEREEDIN Medical Examiner | Medica Examiner | 533436822 | 8557151776 | 67657 DULANOR AMMDAS Street ADORAOIGYy | MD | 27611
FACO16 | ADISENDRA ABRISTIRI Cinic Ginc | 6317471087 2444737224 | 43508 ERYION AQUASHAN Street ADRANIGry | WD | 62132
FACO17 | CUDEGAN DATHAIHIR Lab b 0536510715 | 3463705141 | 27167 BEVARES ATRR Sirest cEDSTIMOGYy | MD | 76676
FAC18 | BABRON DHAR Organization Organization | 2363154312 | 5500062873 | 53078 CALIDRIM CONNIGLRA Street BREOROMGY | MD | 71864
FAC19 | BEREZAED AMAS Medica Examiner Medica Examiner | 7663601035 | 1464075687 | 85087 CADI AGUILTHR Sireet ARGl M | 11081
FAC20 | DONIVEN AGOLOD Other Faty Other Facity | 1384550300 3163514652 03512 ARYSSA DAELELES Stret ADRASSGly | MD | 52268
FAC021 | BEYABANTI Treatment Center Treatment Cen...| 3120402346 | 8425177864 | 23304 AKIN ARAMORTRIN Sreet awGsGly | WD om27

\ FAC-022 | CHINTANN BESESTAN Lab Lab 8150380321 | 8477655155 52565 AMAS ANDAIDRAIA Street /ANDRITH City MD 86181
FAC023 | DOLNITILYA DOLNITILYA Medical Examiner | Medica Examiner | 7366447232 | 3636358663 | 35202 BARA DREZAIRA Street ALHAESTAHCy | MD | 41631

||| Facozs | adeR AntoMERIAN Hospce Hosice | 1546662808 | 1234257333 08464 AYARONN DAGOLATH Street avewscty | Wb e

||| Facozs | eeLcAN ABRIOS Medcal Examiner Medica Examiner | 0462336742 | 1314067288 | 71460 ALTHINAGON ARANDA Street DAGOLATHGY | MD | 24120

||| L _eacozs _ asrios avoarorara Lab L 7433732757 | 4720867340 | 7655 ARANDA BEYA Street. caoerios ity | Mp | 28083~

|| it sesored by revance o crtera.Soring by = oo il coue 5 order o e o

| Losgedin 25 depryfat FAC-000051 (Testing Hospital) | [ Showing Search





The screenshot below shows the default Physician search tab. The search criteria are any license number containing “XYZ-6”. 
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Which fields is search and how (perfect match, starts with or fuzzy search) depends on your registry’s configuration.  You can review the search criteria for your registry by clicking the question mark icon above the Rest button:

[image: image66.png]Use the text fields to provide your search criteria. Different fields will be combined together using the AND operator
To trigger the search, type Enter or click the Search button.

By default, the results are sorted by relevance to the provided criteria; that order can be changed by clicking one of
the columns, but the default order will then be lost. The following fields are searched:

* Last Name (fuzzy)
* First Name (fuzzy)
* NPI (contains)

* License # (contains)
* ID (contains)

To view one of the results, double-click ts row. Use the contextual menu (accessed by clicking on the table of
results with the right button of the mouse) to access more actions related to the table.





SEER*Rx Drugs and Regimens
The SEER*Rx Drugs and Regimens are available in the Search page.  By default no drug is displayed.  Click Search without providing a search term to display all the drugs.
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To search for a particular drug or regimen:

1. Type one or several words in the Search Text.
2. Type Enter or click the Search button.
3. The results are displayed on the left side of the window; they are sorted by relevance to the search terms. The first result is selected by default; to view other drugs or regimens, use the up and down arrows to browse the list of results.

4. The drug or regimen selected in the Results list is shown on the right side of the window.  The search terms found in the fields are displayed in red.  The search is based on 

a. Which field(s) contained the terms (a term found in the Generic Name will yield a higher score than one found in the Remarks for example).

b. How many times the term was found in the field(s).

c. Whether the terms was a perfect match to the field(s), or if the field(s) started with the term, or if the term was only contained in the field(s).

5. By default, if several terms are provided, they will all be required in search fields (this is an AND’ed query).  To require any term instead (an OR’ed query), uncheck the Required all terms checkbox.  The terms are separated by a space; to search for a term containing a space, enclose it with double quotes.

6. To limit the search to drugs only, unselect the Search Regimens checkbox.

7. To limit the search to regimens only, unselect the Search Drugs checkbox.
The following screenshot shows a drug found for the term “adreno”.
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A complex algorithm is used to search the different fields contained in the drugs and regimens.  To view which fields are searched and their corresponding weight, click the question mark button on top of the Reset button:
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‘This page allows you to search the SEER*Rx drugs data

Use the text fields to provide your search criteria
To trigger the search, type Enter or click the Search button.

‘The resuls are sorted by relevance to the provided criteria. The following fields are searched:

* generic name (weight=20)
* brand name (weight=10)
* NSC number: (weight=0)
abbreviation (weight=8)
category (weight=5)
subcategory (weight=S)
remarks (weight=2)
primary site (weight=2)

‘The weight is used to calculate the relevance of the searched term and sort the results accordingly. By defauit, all the
terms provided need to be found in the data (the terms are separated by an AND); uncheck the Require all terms
‘checkbox to switch to a search where at least one term is required (the terms are separated by an OR); using the
second option might return more results. To search for a term containing a space, enclose it in double-quotes.

Results starting with [D] represent a drug, results starting with [R] represent a regimen.

Select a particular result on the left panel to display the corresonding drug or regimen on the right panel. The search
term will be highlighted in red anywhere it appears.

To restrict your search to drugs only or regimens only, use the Search Drugs and Search Regimens checkboxes.





Regimens are displayed differently than the drugs; since they represent a set of drugs, the information panel shows which drugs make up the regimen. The following screenshot shows a regimen found for the term “AC”.
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Since the information panel can contain a lot of data, it might scroll. Therefore it is sometimes useful to be able to hide the Results panel and show the information on the full screen.  To accomplish that use the Ctrl+< shortcut to hide the results (to extend the information panel to the left) and Ctrl+| to show it again (to come back to a split view).  You can always change the amount of horizontal space that each panel uses by dragging the separation between them to the left or to the right.

Hematopoietic Disease Database

The Hematopoietic and Lymphoid Diseases are available in the Search page.  By default no disease is displayed.  Click Search without providing a search term to display all the disease.
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To search for a particular disease:

1. Type one or several words in the Search Text.

2. Type Enter or click the Search button.
3. The results are displayed on the left side of the window; they are sorted by relevance to the search terms. The first result is selected by default; to view other diseases, use the up and down arrows to browse the list of results.

4. The disease selected in the Results list is shown on the right side of the window.  The search terms found in the fields are displayed in red.  The search is based on 

a. Which fields contained the terms (a term found in the Generic Name will yield a higher score than one found in the Remarks).

b. How many times the term was found in the fields.

c. Whether the terms was a perfect match to the field, or if the field started with the term, or if the term was only contained in the field.

5. By default, if several terms are provided, they will all be required in search fields (this is an AND’ed query).  To require any term instead (an OR’ed query), uncheck the Required all terms checkbox.  The terms are separated by a space; to search for a term containing a space, enclose it with double quotes.

The following screenshot shows a drug found for the terms “leukemia” and “chronic”.
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A complex algorithm is used to search the different fields contained in the drugs and regimens.  To view which fields are searched and their corresponding weight, click the question mark button on top of the Reset button:
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‘This page allows you to search the Hematopoietic and Lymphoid Database for diseases.
Use the text fields to provide your search criteria
To trigger the search, type Enter or click the Search button.

‘The resuls are sorted by relevance to the provided criteria. The following fields are searched:

* name (sweight=100)
* code (weight=100)
* alternate name (wweight=10)

‘The weight is used to calculate the relevance of the searched term and sort the results accordingly. By defauit, all the
terms provided need to be found in the data (the terms are separated by an AND); uncheck the Require all terms
‘checkbox to switch to a search where at least one term is required (the terms are separated by an OR); using the
second option might return more results. To search for a term containing a space, enclose it in double-quotes.

Select a particular result on the left panel to display the corresonding disease on the right panel. The search term will
‘be highlighted in red anywhere it appears.





Since the information panel can contain a lot of data, it might scroll. Therefore it is sometimes useful to be able to hide the Results panel and show the information on the full screen.  To accomplish that use the Ctrl+< shortcut to hide the results (to extend the information panel to the left) and Ctrl+| to show it again (to come back to a split view).  You can always change the amount of horizontal space that each panel uses by dragging the separation between them to the left or to the right.

Section 6:  Synchronizing SEER*Abs with the Central Registry

The Synchronization module allows you to update your copy of SEER*Abs with data from the registry’s main database; and it allows you to create extracts that can be used to submit your data to the registry.  Data imported into SEER*Abs include AFLs requiring attention and reference data.  The reference data includes lookup tables, facility and contact lists, consolidated patient data, and unconsolidated patient records.
The type of the reference data and how it is imported is configured differently in each Registry.  The following screenshot shows the default application in which the reference data can be imported from files or from a connection to the Central Registry’s database.
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Exporting Data

Updated AFLs and completed records can be exported from SEER*Abs into external files for submission to the central registry or through a straight database update (the second method is not enabled in the default configuration provided with the application). 

To export record and/or AFLs:

1. Go to the Synchronization page (press F4; click the Synchronization toolbar icon; or select Show -> Synchronization).

2. In the Export Data section, click the Create Data Files button.  The following dialog will be displayed:
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3. Check the data types you wish to export.

a. The number of records/AFLs that can be extracted is shown in parenthesis after the data type label; if a particular type has no entity that can be extracted, it will be disabled. 
b. The system generates a unique file name for the extract.  You can modify the file name by editing it in the text box, or you can use the browse button to select a different location.

c. It is recommended that you extract Abstracts whenever you extract AFLs and vice versa.  

4. Click OK.  SEER*Abs will execute each script and indicate whether the script executed successfully or if errors were encountered.  
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5. Click Close.

Once the process is done, the extracted records/AFL will be flagged as ARCHIVED.  Archived entities are read-only and cannot be modified anymore.
To view the history of the exports, click the View Export History button.  A dialog will be displayed with a table containing one row for each extracted data type.  Click on one of the columns to sort the rows according to the data contained in the column. 
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Importing Data

Data can be imported into SEER*Abs directly from a database or can be imported from external files.  The IT staff responsible for configuration the application should tell you which method will be used in your registry.  If importing files is enabled, an Import Data File button will be shown on the synchronization page; if downloading data from the Central Registry’s database is enabled, a Download from Central Registry button will be shown.  If external files will be used, please be sure you understand when new files will be created for your use.

There are several types of data that can be imported.

1. Lookup – The codes and corresponding meanings for the various fields in SEER*Abs.  This must be imported before you can begin using SEER*Abs.

2. Facility – The facilities (hospitals, labs, etc) associated with your registry.  This must be imported before you can begin using SEER*Abs.  This allows you to indicate where you are collecting data when you log in, as well as capture where events occurred in the records you are creating.

3. Physicians – The physicians associated with your registry.  This should be imported before you begin using SEER*Abs.  This allows you to capture which doctors interacted with the patients in the records you are creating.

4. AFL – Abstract Facility Leads (AFLs) represent the tasks within SEER*Abs.  An AFL should contain enough information about the patient (e.g. Name, SSN, DOB, etc), the cancer (e.g. Site, Laterality, Date, etc) and facility (Facility ID) to enable you to create the desired abstracts.  This should be imported before you begin using SEER*Abs.

5. Reference Data – Data already captured in the central registry.  This would allow you to review what is already known about the patient and cancer before you create a new record.  Not all registries will choose to have this information available to their abstractors.  If your registry does provide this information, then the reference data should be imported before you begin using SEER*Abs.  Reference data can include the following (as originally shipped), but the exact types would be controlled by the configurations set by your registry staff.

a. Patient – the consolidated information for a patient, all their related tumors and whatever admission and treatment information your registry chooses to provide.

b. Record (NAACCR) –Abstracts in NAACCR format that has arrived at the central registry but has not yet been processed; data that is unlinked and unconsolidated.
c. Again, the exact components of the reference data, or even if it is available at all, are controlled by your registry.

You should import data into SEER*Abs before you start to use SEER*Abs in the field.  Since the information in the central registry is constantly being updated, this import should be done regularly.

To import data into SEER*Abs:

1. Go to the Synchronization page (press F4; click the Synchronization toolbar icon; or select Show -> Synchronization).

2. In the Import Reference Data section, click the button corresponding to the synchronization method you wish to use:

a. Download from Central Registry: a dialog will be displayed; select the data types you wish to download.

[image: image78.png]ynchronization Options - SEER"Abs (LM

Select the type(s) you would ke to download.





b. Import Data Files: a dialog will be displayed; select the data types you wish to download and provide the location of each data file.
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3. Click OK.

4. If you have selected the method Download from Central Registry, will be presented with a Remote Login screen.  The information about the databases you can connect to will be based on configurations set by your registry staff.  They should provide you with the information below.
a. Select the database you wish to Connect To.  
b. Enter the username for that database (there might be a default username provided).
c. Enter the password for that database.
d. Click Login.
5. The Synchronization Progress dialog will appear.  The download takes time to complete, the exact length of which will vary by how much data you are importing.
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6. Click Close.
Once the process is done, the imported data will be available in the application.

To view the history of the imports, click the View Import History button.  A dialog will be displayed with a table containing one row for each data type imported.  Click on one of the columns to sort the rows according to the data contained in the column.
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Recovering an extracted data file
SEER*Abs keeps the last 10 extract files for each data type in its database and allow them to be re-created in case they were not been successfully transmitted to the registry.

To recover an extract:

1. Go to the Synchronization page (press F4; click the Synchronization toolbar icon; or select Show -> Synchronization).

2. Click the Recover Data File button.
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The foloning table shows the extracts that can be recovered (ony the last 10 exracts are avaiable for each data type).

Username Date Data Type File
depryf | 08/04/20119:01AM | Abstract Records | :\seerabs|testloutputlabs_20110804.085750_001.txd





3. Double click on the row of the extract that needs to be re-created.
4. Click the Yes button of the confirmation dialog.
5. Click OK and Close.
6. The file is re-created in the output folder. To open that folder and verify that the file is there, select Show -> Output Folder.
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